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2 What is DiamCalc and who benefit from it 
DiamCalc is a system for cut gemstones modeling, which enables the precise 
calculation of the diamond weight and determination of cut proportions. The real 
(photorealistic) image of a polished diamond created by the system makes it possible 
to determine the cut properties that cannot be measured and to find the optimal 
combination of cut parameters that would provide the best perception (brilliance, fire, 
scintillation etc.) of the stone. 

 
No photograph can show the sparkle and brightness of a real diamond. Until now; 
DiamCalc3.0 (DC3) has High Dynamic Range (HDR) imaging that shows the intense 
sparkles on your computer screen by reproducing the flares or bloom that we see in 

real diamonds. Bright sparkles often appear to be larger than 
the facet they emanate from, even extending outside the edge 
of the diamond.  
 
Scintillation is the last great frontier of diamond cut studies. 
Regular ray tracing software and lab grading systems have 
failed to model scintillation and capture this «bloom» factor. 
Now buyers and sellers can realistically show a client, or 
visualize a distant diamond themselves before buying it. 
They can see just how it will look as they rock it from side to 
side in their own environment and even make promotional 

videos for individual diamonds. Please see the examples of Demo Movies 
 

http://www.octonus.com/oct/products/3dcalc/standard/hdrdemomovie.phtml
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DiamCalc’s High Dynamic Range lighting can come from a variety of panoramas such 
as a ball room, forest or hillside so anyone can see how the diamond will look in each 
of these environments. Jewelers of the future will no doubt import panoramic images 
of their own sales floor into DiamCalc. 
 
The result of new technologies is the highly 
photorealistic images reflecting both non-trivial optical 
properties of gemstones and compound features of 
environment as shown here where the diamond is 
positioned above a virtual sheet of paper with a grid 
pattern. 
 
The Diamond calculator is designed for jewelers, 
diamond graders, sale specialists dealing with 
diamonds and diamond jewelry, for companies active 
in designing special cuts, manufacturers and 
technologists. 
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3 What is new in the DiamCalc 3.0 ? 

3.1 New features in the photorealistic rendering mode 

• Light bloom or flare effect 
• Lighting with external high dynamic range panorama (HDR) 
• Lighting with generated panorama (zones and light sources) 
• Paper sheet environment 
• Observer model 

Bloom effect 

The bloom or flare effect produces fringes of light around very bright objects in an 
image, as stressed by the red squares in the actual rendering screenshot below: 
 

The physical basis of bloom is 
that lenses (including those in our 
eyes) can never focus perfectly in 
the real world. Under normal 
circumstances, these focus 
imperfections are not noticeable, 
but an intensely bright light 
source will cause the 
imperfections to become visible. 
As a result, the image of the 
bright light appears to spread 
(bleeds) beyond its actual 
borders. 
 
Depending on the background 
colour or shade, the bloom can 
appear to extend outside the 
edges of the diamond. 
 

Lighting panorama with high dynamic range (HDR) 
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A lighting environment can be defined by a high dynamic range panorama (also 
referred to as HDR panorama). Luminance or radiance observed in the real world can 
usually be stored in special high dynamic range images that correspond to actual 
physical values. This additional information makes high dynamic range images that 
are different to traditional digital images that may appear on a monitor or on a paper 
print. For example in the photo image above the bright parts of the sky radiate much 
more light than is seen in a regular photograph, and such intense light sources can 
create a bloom or flare in a gemstone. 

Lighting with generated panorama (zones and light sources) 

Panoramas with different light sources can be generated by specifying the size and 
quantity of light sources. 

 
Panoramas with colored zones (up to 8 zones) can also be generated.  

 
A panorama for the «Office» lighting environment can also be generated. 
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Paper sheet environment 

A paper sheet can be rendered either using an 
external texture or one that is a generated in 
a grid-style. In the latter case, you can 
customize grid settings, paper color, size and 
other options. 

Observer model 

DiamCalc 3.0 supports a 2D observer model. 
The observer model consists of two parts: the 
observer head and the observer body. This 
observer model design allows simulation of a 
head inclined above a gem being observed. 
You can set up the observer height, eye 
position, shoulder position, head incline 
angle and mask parameters. 

3.2 ETAS images 

Additional features in new version of DiamCalc include ETAS images (effective total 
angular size) which at a glance give a good indication of where a diamond can gather 
light that creates brightness and sparkle. The image on the left shows an ETAS images 
from the diamonds perspective overlain on the HDR image of the observer placed 
inside a ballroom. The image on the right is a DETAS image for an emerald cut that 
shows the dynamic probability to see a sparkle as the diamond is rocked through a 
small range of north south motion.  
ETAS is the basic functional 
tool for the quantification of 
the basic light performance 
responses calculated by 
DiamCalc3. But DiamCalc3 
takes this a further stage by 
computing for two eyes and 
other observer specific 
variables such as pupil size 
and viewing distance. 
Dynamic ETAS  (DETAS) is 
a metric for quantification of scintillation. 

3.3 Cut Designer tool builds variable models 

For companies active in designing special cuts such as many Sightholders, Tiffany and 
Swarovski, the new cut designer tool enables the creation of parametric models with 
tied proportions; each and parameters can be varied. This overcomes a problem in 
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previous computer aided design software that required the laborious creation of 
separate models for every new proportion set. 

 

3.4 Simulation algorithm for stereoscopic photorealistic view of 
diamond is improved 

Algorithm used in simulation of stereoscopic photorealistic view of diamond has been 
found incorrect in some cases (this algorithm is implemented when "Observer\Head 
and eyes\Brain picture\Smart bright" option is selected and also when "Light return 
stereo" Cut Quality index is computed). So the computation was redesigned and the 
photorealistic image in the mentioned mode and "Light return stereo" index values will 
differ from those obtained in older versions. 
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3.5 Added Natural Diamond and Cubic Zirconia to the list of 
materials for setting refraction in Gem properties 

Open panel Gem properties from menu Gem Material -> View / Modify properties… 
Press button Select from list… The panel Gem material list will open. Where you can 
find new materials. 

 

3.6 Added the new GIA appraiser for Brilliant cut. It is named 
GIA_PCT_2006 

This appraiser provides estimation of the overall cut quality, using several cut 
parameters simultaneously, namely Pavilion, Crown and Table. The parameters that 
are taken into account during stone appraisal are displayed in gray, red or green color. 
The red color means that it is necessary to decrease the parameter value to get to a 
better group, the green color suggests to increase the parameter value. There is also a 
special button «Better group» that changes all parameters of the stone to move it to a 
nearest better group. Organization of this appraiser is similar to AGS_2005. 
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4 New photorealistic HDR rendering options 

4.1 Getting started with new photorealistic rendering options 

To configure and set the rendering mode options, select Options->HDR Settings, as 
shown in the screen shot below: 

 
Once Options->HDR Settings is selected, the new dialog box appears to the right: 
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The HDR Settings dialog consists of Tabs and Groups: 

 
 
There are four tabs in the HDR Settings dialog, as listed below:  

• Rendering 
• Panorama 
• Paper 
• Observer 
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Every tab has its own groups. For example, the groups for the Rendering tab are 
shown in the screen shot above. 
You can hide/show a group by clicking on its title. That is, clicking a title of the group 
being shown makes the group area collapse; clicking a hidden group title makes the 
group area appear again, as shown below: 
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4.2 The Rendering tab 

 

In the Rendering tab, you can disable 
or enable showing several effects, 
such as bloom or anti-aliasing 
(Smoothing the jagged appearance of 
diagonal lines in a bitmapped 
image). To show an effect just 
checks the appropriate field. 
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4.3 The Panorama tab 

 

The Panorama tab consists of a 
preview window which is always 
shown at the top and several groups 
below. These groups below can be 
scrolled up and down for the 
Panorama (and observer) tab groups 
using a very narrow pale blue bar on 
the right. 
More detailed explanations of the 
preview window and the Panorama 
tab groups follow: 
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The Preview window 

The Preview window allows you to see 
the current panorama, either a loaded 
one or a generated one, or both overlain 
together. 
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The General group 

The General group allows you to set 
the panorama size. 
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The Lights group 

First check the box Enables light 
sources in the group parameters. 
 
Once the Enable light sources check 
box is checked, you can generate light 
sources for the panorama. You can 
specify the light sources diameter and 
intervals between them. In accordance 
with your data input, the light sources 
will be placed all over the sphere 
automatically. Unfortunately it is not 
possible to choose light source 
positions individually, although you 
can choose whether to distribute light 
sources over the upper hemisphere only 
or the entire panorama. 
 
You can also specify light sources 
blurring parameters and color 
multiplier. 
 
Under Standard lighting subgroup 
you can specify if any of the standard 
lighting presets should be used. 
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The Hemisphere group 

The Hemisphere group contains the 
Enable light hemisphere check box as 
its first element, which is initially 
unchecked. Checking the Enable light 
hemisphere check box allows 
generation of a synthetic panorama 
consisting of zones, as discussed later 
in the Zones Tutorial. 
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The External group 

An external high dynamic range 
panorama can be loaded here. Check 
Enable external image and press the 
Load button (this button marked red on 
screenshot), then you can load any .hdr 
file: 
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4.4 The Paper tab 

 

In this tab, you can adjust the 
properties and the look of the paper 
texture. 
 
The dialog lets you to choose 
whether you want to use an existing 
picture of a real paper sheet or 
generate an artificial grid. The 
selection buttons highlighted green 
in the screenshot allow you to switch 
these two modes: if the Load 
Texture button is checked, a 
provided external picture will be 
used as the paper texture. If you 
prefer to use an artificially generated 
squared paper imitation grid as the 
paper texture, check the Generate 
Grid button. 
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The General settings group allows 
you to adjust the paper sheet options, 
as it appears in the rendering window. 
 
The Size setting affects the size of the 
paper rectangle. 
 
Distance determines the paper offset 
relative to the gemstone position. A 
negative value of –n mm moves the 
paper n millimeters behind the 
gemstone. For instance, the value of -
5.00 shown in the screenshot, places 
the paper five millimeters behind the 
stone. 
 
The Texture size setting determines 
how big the paper texture will be. The 
bigger texture — the more details 
(providing the original image is at 
least as big as the selected texture size, 
in case of external picture use). 
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To load a texture, check Load 
Texture: 
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The Browse button is enabled now, so 
you can press it and select the desired 
paper image from your disk.  
The supported file format is HDR, or 
High Dynamic Range image. 
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To generate a squared paper imitation 
grid, check Generate Grid: 
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Set the grid options: 
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4.5 The Observer tab 

The Observer tab contains controls 
responsible for the observer image, 
position and posture parameters, as 
well as the eyes position and shoulder 
line setting. 
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To load an external observer picture, 
press Browse and choose a PNG file: 
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To set observer parameters, such as the 
observer height, eyes position, shoulder 
line position and head incline angle, 
you can use the Observer parameters 
group: 
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Alternatively, you can press the Set 
Parameters button and use an intuitive 
graphical dialog to set these 
parameters: 



32 
 

 

 
  
 

Here is the dialog: 

  
Make sure you're in Image mode: 
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You can zoom in and out by checking 
the zoom button and then clicking on a 
point of interest on the observer image 
to zoom. Left click zooms in, while 
right click zooms out: 

  
For free-hand image scrolling, use the 
button with a hand icon: 
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To set the eyes position, press the eye-
labeled button and left click on the 
specific point on the observer image 
where you want the eye point to be 
placed (normally this point should be 
between the eyes of the observer): 

  
To set shoulders position, press the 
button with a shoulder line pictogram 
and place the line (by left clicking on 
the observer image) where the 
shoulders should be:  
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You can learn about the current image 
transparency mask by choosing the 
Selection mode. This should be 
particularly handy for BMP images: 
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4.6 Making a synthetic panorama with zones 

Step 1: Beginning 

Check the Enable light hemisphere 
check box in the Panorama tab, 
Hemisphere group. The left side of this 
dialogue box is the lower part of the 
hemisphere and the right side is the 
upper zenith: 
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Step 2. Configuring the leftmost zone 

There are two zones available by 
default: the one on the right and the 
one on the left. 
 
To select the leftmost zone, click the 
square on the left edge of zones 
control: 
 
The Current Zone subgroup below the 
zones control represents parameter 
values for the currently selected zone: 
Border, Cosine power, Color and 
Color multiplier. 
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As you can see by selecting the 
leftmost zone square, this zone border 
is fixed: the Border (degrees) 
parameter is set to -90.0 degrees and 
you cannot change this value. You can 
change Cosine power, Color and 
Color multiplier for the leftmost zone. 
 
For example, to change the color of the 
zone, press the drop-down list arrow 
for the Color parameter: 

 
  
Clicking the arrow will open the color 
picker window: 
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In the color picker window, you can 
choose the zone color you want. The 
screenshot below illustrates the green 
color chosen for the leftmost zone: 
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In addition to the ability of changing 
the zone color, you may want to 
change the value of either Cosine 
power or Color multiplier, or both. 
 
To change the appropriate parameter 
value, type a modified value in the 
corresponding box: 

 
With the new values for Cosine power and Color multiplier parameters submitted, 
you can instantly see their impact on the panorama presented in the Preview window at 
the top of the Panorama tab. 
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Step 3. Configuring an inner zone 

To select an inner zone, click the arrow 
at the middle of zones control: 

 
In the Current Zone subgroup, you can see the parameters values for the zone 
selected. Setting up inner zone parameters is similar to that of the leftmost zone, 
described in the previous section. 
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There are two ways of changing the 
angle of the inner zone border. The first 
way is to type the value between -90 
and 90 degrees into the text box: 
 
When a new value for the Border 
parameter is entered, you can see the 
inner zone arrow automatically change 
its position on the zones control. 

 
You can achieve the same effect in a different way. Select the inner zone arrow and 
drag it to the new preferred position. You can just click on the zone you want and hold 
the mouse button down while moving the mouse cursor to a position where you want 
the zone to be placed: 
 
The Borders (degrees) field displays its new value automatically. 
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Step 4. Adding new zones 

To add a new zone to the panorama, 
press Add Border button: 

 
  
As the result of pressing the Add 
Border button, you will see a new 
arrow appear in the middle of the zones 
control. 

 

 
All new zones appear in 0.0 degrees position with white color and the default values 
for cosine power and color multiplier parameters. The new arrow is selected by 
default, so that you can instantly proceed with configuring this zone’s parameters, as 
discussed in step 3.  
You can change the selected zone at any time by choosing an arrow corresponding to 
the zone you need to adjust.  
If you press Add Border button twice or several times while not changing arrow 
positions, the new arrow will be placed above the one added before. 
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The maximum number of zones is 8: 
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Step 5. Removing the zone 

To remove the zone, you should first 
select the zone you want to remove. 
To select a zone, choose the 
corresponding arrow or left click on the 
zone area. Make sure the zone you 
want to remove is selected: the arrow 
changes its appearance to bold and the 
Current Zone subgroup contains the 
color of the zone you have chosen. 
After selecting the zone desired for 
removal, press Remove Border button. 
The zone will be removed.  
You can remove all zones except for 
the leftmost zone (i.e. the one that has 
its border fixed to -90 degrees). 
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Step 6. Viewing the created panorama with the diamond 

Press Apply button at the bottom of the HDR Settings dialog to generate the 
panorama: 
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You can see the diamond rendered using the generated panorama in the main 
application window: 
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5 Creating High dynamic range (HDR) panorama by third-
party software 

You can create high dynamic range panorama for DiamCalc using any editor, which 
supports 32-bit per channel color mode.  
 
For example, you can use: 
 

• Adobe Photoshop CS3 Extended (http://www.adobe.com/downloads/ ) 
• Adobe Photoshop CS (http://www.adobe.com/downloads/ ) 
• Artizen HDR (http://www.supportingcomputers.net/) 

5.1 The idea of mapping an image onto the sphere 

The panorama  image used for DiamCalc 3.0  needs to be in what’s known as 
«equidistant cylindrical projection», more commonly called a «cylindrical map». The 
image is wrapped onto the sphere. 
We load the image like this: 

 
And we get the environment of the diamond (diamond is somewhere inside this 
sphere): 

 

http://www.adobe.com/downloads/
http://www.adobe.com/downloads/
http://www.supportingcomputers.net/


49 
 

 

 
  
 

Here is an example of creating your own HDR panorama. 
 
1. The top hemisphere should look like 
this: 
 

2. And the bottom hemisphere is black: 

*(green lines show the axis)  
 
3. Then the panorama image will be: 4. When your image 

wrap the sphere, it looks 
like this: 
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5.2 Adobe Photoshop CS3 Extended 

Choose File->New from the menu panel 

 
The dialog box with new image options will appear. Here you should change width 
and heights. Remember that height should be two times less than weight, but of them 
should be power of 2 (such as 1024x512, 512x256, etc.) 
Then, be sure that Color Mode is set to RGB Color and 32 bit 

 
The blank image will appear and you can edit it. 
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When you finished editing, you should save it in HDR file format. Choose File->Save 
as... from the menu panel. 

 
The dialog of all supported formats will appear. Make sure, that HDR file format was 
chosen. For being sure, type .hdr at the end of the filename. 
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5.3 Adobe Photoshop CS 

Formally Adobe Photoshop CS can't create 32-bit per channel images, but you can 
create 16-bit HDR and work with it (most of the time it will work correctly, but for 
better result use Adobe Photoshop CS3 or other software, which can create 32-bit per 
channel images). 
 
Choose File->New from the menu panel 

 
The dialog box with new image options will appear. Here you should change width 
and heights. Remember that height should be two times less than weight, but of them 
should be power of 2 (such as 1024x512, 512x256, etc) 
 
Then, be sure that Color Mode is set to RGB Color and 16 bit 

 
The blank image will appear and you can edit it  



53 
 

 

 
  
 

When you finished editing, you should save it in HDR file format. Choose File->Save 
as... from the menu panel 

 
The dialog of all supported formats will appear. Make sure, that HDR file format was 
chosen. In Adobe Photoshop CS you should type .hdr at the end of the filename. If you 
forgot to do it .dds format will be set by default and it won't work with DiamCalc 3.0. 

 
When you click Save button the dialog will appear. Pixel format for the output file 
should be A32B32G32R32F. Then press OK 

 
In the next dialog choose Yes, scale between maximum values 
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5.4 Artizen HDR 

Choose File->From Scratch.. 

 
In the following dialog set Width, Height and Color Space. Remember that height 
should be two times less than weight, but of them should be power of 2 (such as 
1024x512, 512x256, etc.). Color space should be 32 Bits/Channel (RGBA) 

 
The blank image will appear and you can edit it 
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When you finished editing, you should save it in HDR file format. Choose File->Save 
as... from the menu panel 

 
The dialog of all supported formats will appear. Make sure, that HDR file format was 
chosen. Press Save button. 

 
Then you should set Gamma Correction to 2.2 and click Apply button 

 
 



56 
 

 

 
  
 

6 Creating Cuts with Cut Designer 

6.1 Getting started with Cut Designer 

Open panel Advanced cut edit from menu Cut / Cut designer… The Utility allows 
constructing different types of cuts. There are Cut editor dialog window on the left 
side and model view on the right side.  

 
 
The panel on the top allows switching different types of the model view: 
 

  
 

• Remove all splits of the model view 
• Split model view in two (vertical) 
• Split model view in two (horizontal) 
• Split model view in four 
• Synchronize zoom factor in All view during  change 
• Rotate all view synchronously 
• Show coordinate system axes in all views 
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The general settings of cut are displayed on the left top side of the panel below.  
• Gear notch quantity  
• Radial symmetry degree 
• Mirror symmetry 
• Preform proportions 

You can change general settings in the panels Edit symmetry settings and Edit preform 
Settings (witch opened with buttons marked as red on the picture below): 

 
 
Symmetry settings panel: Preform settings panel: 

 
 

You can set diameter on the top of panel.  
Buttons Girdle, +, -, Table/Culet allow constructing facets. You can save cut, load cut 
and export to DC on the bottom of panel. 
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Please see the examples of creating Round brilliant, Princess and Gabrielle below. 

6.2 Creating Brilliant cut 

General settings (as defaults) 

Edit Symmetry Settings: 
• Degree of radial symmetry: 8 
• Gear notch quantity: 96 
• Mirror symmetry: YES 

Edit Preform Settings: 
• X dimension: 1 
• Y dimension: 1 
• Z dimension: 4 

Cutting Steps 

 

Step Result 

1  
 

• Gear index: 1 
• Degree of radial symmetry: 32 

 

2  + Mains 
• Gear index: 0 
• Angle: 41 
• Degree of radial symmetry: 8 

 



59 
 

 

 
  
 

 + Facet through two points 
• Gear index: 3 
• Degree of radial symmetry: 8 
• Use symmetry: YES 
• 1st pt. Point on existing vertex. 

Select the vertex marked by blue point. Put on yellow 
point:  

• 2nd pt. Point on edge with proportions. 
 
Select the edge point marked with yellow (Proportion 
value is about 70%): 
 
 
 

3 

Facets are ready: 

4  
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5  + Mains 
 

• Gear index: 0 
• Angle: 33 

Degree of radial symmetry: 8 

6  + Facet through two points 
• Gear index: 3 
• Degree of radial symmetry: 8 
• Use symmetry: YES 
• 1st pt. Point on existing vertex. 

Select the vertex marked by blue point. Put on yellow 
point: 

 • 2nd pt. Point on edge with proportions. 
 
Select the edge point marked with yellow (Proportion 
value is about 20%): 
 

 Facets are ready. 
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7  + Facet through one point 
• Gear index: 6 
• Angle: 15 
• Degree of radial symmetry: 8 
• Use symmetry: YES 

Point on existing vertex 
Select the vertex marked with yellow: 

 Facets are ready. 

8  + Point on existing vertex 
 
Select the vertex marked with yellow: 
 
 
 

 Table is ready. 
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9 Return to the 2nd step (Mains, 8 facets) and change 
Z-coordinate of First constraint point to 0.05 

 

 
The cut is ready. Press button  
 

6.3 Save Cut, Load cut and Export to DC. 

You can save, load and export created cuts. Press button Save cut..The cut will be 
saved in xml format. The xml file you be able to store or send via e-mail.  
Press button Load cut..to open saved cut. 

 
Press button Export to DC. Type a name for new cut and press Ok. 

 
 
The Cut Designer will be closed and you can explore 
created cut in DiamCalc (see screenshot below). 
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New cuts from Cut designer you can find in the external cut list. 

 
If you need addition information about exported cuts please open panel Parametric 
cuts info from menu Cut. Exported cuts from Cut Designer are included in the 
GingemaUser.dll 
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6.4 Creating Princess cut 

General settings 

Edit Symmetry Settings: 
• Degree of radial symmetry: 4 
• Gear notch quantity: 120 
• Mirror symmetry: YES 

Edit Preform Settings: 
• X dimension: 1 
• Y dimension: 1 
• Z dimension: 4 

Cutting Steps 

Step Result 

1  + Mains 
• Gear index: 0 
• Angle: 45 
• Degree of radial symmetry: 4 

2  + Facet through one point 
• Gear index: 0 
• Angle: 40 
• Degree of radial symmetry: 4 
• Use symmetry: YES 
• Point on edge with proportions 

 
Select the edge point marked with yellow 
(Proportion value is about 20%): 
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Facets are ready. 

 + Facet through one point 
• Gear index: 5 
• Angle: 20 
• Degree of radial symmetry: 4 
• Use symmetry: YES 
• Point on existing vertex 

 
Select the vertex marked with yellow: 
 

3 

Facets are ready. 

4  + Point on existing vertex 
 
Select the vertex marked with yellow: 
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Table is ready. 

 

5  + Mains 
• Gear index: 0 
• Angle: 50 
• Degree of radial symmetry: 4 

6  + Facet through one point 
• Gear index: 1 
• Angle: 47.5 
• Degree of radial symmetry: 4 
• Use symmetry: YES 
• Point on existing vertex 

 
Select the vertex marked with yellow: 
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 Facets are ready. 

 + Facet through two points 
• Gear index: 14 
• Degree of radial symmetry: 4 
• Use symmetry: YES 
• 1st pt. Point on existing vertex 

 
Select the vertex marked with yellow: 
 

• 2nd pt. Point on edge with proportions 
 
Select the edge point marked with yellow 
(Proportion value is about 45%): 
 

7 

Facets are ready. 
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 + Facet through two points 
• Gear index: 15 
• Degree of radial symmetry: 4 
• Use symmetry: YES 
• 1st pt. Point on existing vertex 

 
Select the vertex marked with yellow: 
 

• 2nd pt. Point on edge with proportions 
 
Select the edge point marked with yellow 
(Proportion value is about 70%): 
 

8 

Facets are ready. 

9 Z-coordinate fixing: 
Return to the 1st step (Mains, 4 facets) and change 
Z-coordinate of First constraint point to -0.65. 
Return to the 5th step (Mains, 4 facets) and change 
Z-coordinate of First constraint point to -0.50. 
 

 
The cut is ready. 
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6.5 Creating Gabrielle cut 

General settings 

Edit Symmetry Settings: 
• Degree of radial symmetry: 8 
• Gear notch quantity: 96 
• Mirror symmetry: YES 

 
Edit Preform Settings: 

• X dimension: 1 
• Y dimension: 1 
• Z dimension: 4 

Cutting Steps 

Step Result 

1  
• Gear index: 1 
• Degree of radial symmetry: 32 

2  + Mains 
• Gear index: 0 
• Angle: 41 
• Degree of radial symmetry: 8 
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 + Facet through two points 
• Gear index: 3 
• Degree of radial symmetry: 8 
• Use symmetry: YES 
• 1st pt. Point on existing vertex 

Select the vertex marked with yellow: 
 

2nd pt. Point on edge with proportions. 
 
Select the edge point marked with yellow 
(Proportion value is about 50%): 

3 

Facets are ready. 

4  + Facet through one point 
• Gear index: 2 
• Angle: 33 
• Degree of radial symmetry: 8 
• Use symmetry: YES 
• Point on existing vertex 

 
Select the vertex marked with yellow: 
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Facets are ready. 

5  

6  + Mains 
• Gear index: 0 
• Angle: 33 
• Degree of radial symmetry: 8 

7  + Facet through two points 
• Gear index: 3 
• Degree of radial symmetry: 8 
• Use symmetry: YES 
• 1st pt. Point on existing vertex 

Select the vertex marked with yellow: 
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• 2nd pt. Point on edge with proportions 
 
Select the edge point marked with yellow 
(Proportion value is about 25%): 

Facets are ready. 

 + Facet through one point 
• Gear index: 0 
• Angle: 25 
• Degree of radial symmetry: 8 
• Use symmetry: YES 
• Point on existing vertex 

 
Select the vertex marked with yellow: 
 

8 

Facets are ready. 
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 + Facet through one point 
• Gear index: 6 
• Angle: 16 
• Degree of radial symmetry: 8 
• Use symmetry: YES 
• Point on existing vertex 

Select the vertex marked with yellow: 
 

9 

Facets are ready. 

 + Point on existing vertex 
 
Select the vertex marked with yellow: 
 

10 

Table is ready. 
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11 Return to the 2nd step (Mains, 8 facets) and change 
Z-coordinate of First constraint point to 0.05 
 

 
The cut is ready.  
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7 Estimating the mass of the stone and calculating cut 
parameters 

DiamCalc allows to estimate the mass of the stone by entering known proportions and 
calculate different cut parameters one from another. 
Experts and dealers usually use formulas, tables, or calculators to estimate the mass of 
mounted diamonds. These methods often give approximate results, as they can take 
into account only a predefined set of parameters. DiamCalc allows to perform 
calculation making full use of any set of proportions that can be measured in a given 
case. 
A similar problem exists in diamond marking. DiamCalc provides a unique 
opportunity to estimate parameters of a future diamond as precisely as the available 
data allows. 

7.1 Mass estimation. Setting diamond parameters 

To estimate the diamond mass with DiamCalc, one should choose a cut style and input 
the main parameters (e.g. the diameter). The stone mass is promptly displayed in the 
relevant field. The other parameters should be specified for more accurate weight 
estimation. 
Let us see how it is done. Start DiamCalc and look at the panel with parameters. All 
parameters have some values. Marquise cut is selected initially (see «Shape and cut» 
drop-down box). Initial diameter of the stone is 6.00 mm (assume this is what we 
need). Now we can enter all parameters that we know to describe the diamond as 
precisely as possible. To change a parameter, select a value in the corresponding box 
by the mouse and type in a new value, pressing Enter at the end. 
 
For example, let us set a different value 
for the total height. Select a field right to 
«Total height» caption. At this moment, 
the panel with diamond parameters should 
look like the following: 
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As one can see, the current value of the 
diamond's total height is 3.67 mm (or 
61.2% of the diameter), and the mass is 
1.61 ct. Now when the «Total Height» 
value is selected on the panel above, type 
3.78 on the keyboard to increase the total 
height to 3.78 mm (or 63.0% of the 
diameter). Press Enter key. DiamCalc will 
recalculate all parameters and the panel 
with parameters will look like: 
 

 
 
Note that the diameter remains the same (6 mm), both crown and pavilion heights have 
increased proportionally to accommodate to a total height increase, and the mass has 
been recalculated using a new piece of information: 1.65 ct. 
Other parameters can be changed the same way: select the corresponding value, enter a 
new one from the keyboard and press Enter key. 

7.2 How to get additional information on a parameter 

If the meaning of some parameter is not clear, move mouse cursor to the 
corresponding box and leave it there, not pressing any keys or buttons. In couple of 
seconds, a hint with the description of the parameter will pop up. 
 
For instance, moving the mouse cursor to 
the value of «Sec. diameter» parameter 
will produce the following effect: 
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8 Support for different cuts and parameters 
DiamCalc supports all main cut types and allows to view or change a large set of 
parameters, including advanced ones. 
DiamCalc Standard supports 13 main cut types. There is a set of cut parameters 
(diameter, crown height, ...) which are common for all cuts. Also there are some 
advanced cut-specific parameters, which allow to handle some rare cuts (for example, 
old round cuts). 
Note. The free demo-version of DiamCalc supports Marquise cut only. Although the 
demo-version is fully functional, some cut-specific parameters (e.g. advanced 
parameters of Brilliant diamonds - see below) cannot be seen in the demo-version. 

8.1 Working with different cuts 

DiamCalc Standard supports the following cut types: Baguette, Brilliant, Emerald, 
Flanders, Happy-8, Heart, Marquise, Oval, Pear, Princess 2-chevron, Princess 3-
chevron, Prism and Radiant 
The current shape is shown in «Shape and cut» drop-down box. Setting a desired cut 
type is the first thing that should be done when parameters of a new diamond are 
entered. To change a cut type, click «Shape and cut» box with a mouse. A list of 
possible values appear. Clicking on a cut type in this list will select this cut. A 
diamond image in the left half of Diamond Calculator window will change, displaying 
a diamond of a newly selected cut. 

8.2 Working with cut parameters 

DiamCalc displays cut parameters in a 
parameter panel, which is located in the 
right half of the application's window. 
A notebook-like structure has three tabs: 
Proportions, Advanced and Advanced2. 
Proportions tab holds most common 
parameters, such as diamond diameter, 
total height, etc. Most values can be 
adjusted to describe the stone more 
precisely. If only some proportions are 
known, DiamCalc assigns reasonable 
estimates for parameters that cannot be 
measured. 
 

 

 
There are two different methods of changing parameter's value. First, a new value can 
be entered directly from the keyboard. To do this, select a chosen parameter value with 
the mouse, type in a new value, and press Enter key at the end. The other method is to 
use  buttons that are on the right of each parameter which value can be changed. 
Note that a slider named «Step» allows to tune the amount by which those buttons 
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change the value. For example, when the slider is average (default) positions,  
buttons change the diameter by 0.1 mm; when it is in the «Fine» position, those same 
buttons change the diameter by 0.01 mm. 
See also «Selecting measurement units and parameters to show» section that describes 
how to change presentation of some parameters: select one of available measurement 
units, choose one of similar parameters («dual» parameters), etc. 

8.3 Advanced parameters (old cuts, etc) 

The parameters on Advanced page of 
parameter panel usually depend on the 
current cut. Let us examine parameters 
that are available for Brilliant cut 
diamonds. 
 

 

8.4 Advanced parameters (old cuts, etc) 

In addition some predefined parameters values («fixed cuts») can be used to change 
the diamond proportion. With the menu Diamond  Fixed cut you will be presented 
with the list of «fixed cuts» available for the selected diamond shape. For example, if 
you want to see «Parker» brilliant model you should select «brilliant» shape and then 
call Diamond  Fixed cut  Parker menu. «Fixed cut» affects all the cut parameters 
except the diameter. «Fixed cuts» are stored in the appraiser data file (see the topic 
«Appraising diamonds quality and pricing diamonds») as a text, so parameter values 
can be modified and new fixed cuts can be defined as well. 
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9 Finding unknown parameters. Parameter fixing 
DiamCalc allows to recover values of diamond proportions that cannot be measured 
directly (e.g. because stone is mounted). 
Diamond Calculator was designed to give maximum flexibility in a wide range of 
situations. Mounted stones can be difficult for direct measuring, and in different cases 
some parameters may or may not be available. 
Another challenge is to estimate a parameter in a diamond that does not exist yet, 
given proportions of a rough diamond, a semi-cut diamond or a polished diamond that 
will be re-cut. With Diamond Calculator, this task is as easy as the previous one. Any 
set of existing limitations can be entered into DiamCalc to find missing parameters of 
a future diamond without any tables or formulas. 

9.1 Ways to estimate unknown parameters 

The simplest way to estimate unknown parameters with DiamCalc is just to enter all 
known values. DiamCalc will produce a reasonable estimation of other parameters. 
In practice, the process can be a bit longer due to the fact that the parameters can affect 
each other. For example, changing crown angle will lead to a change of either the table 
diameter or the crown height. Relationships between parameters can be quite complex. 
To neutralize this effect, it may be required to adjust parameter's value once more after 
it was automatically recalculated due to a change of another parameter. One more 
option of handling this problem is parameter fixing (see below). 
Another way to find parameters that cannot be measured directly is to examine the 
diamond image produced by DiamCalc, adjusting parameters until the computer image 
looks similar to the real stone. See section on controlling visual representation of the 
stone for more information.  
Note, that a computing-intensive Photoreal mode is the most suitable for the purpose, 
so that a powerful enough computer is required to quickly display the image when 
parameters are changing. 

9.2 Parameter fixing  

Some parameters have a small button with a lock on it on the left of the parameter's 
name. These Lock buttons allow to fix the parameter value to avoid an accidental 
change or a change due to interrelation between parameters. 
Example of using Lock buttons (measuring parameters of mounted diamonds). 
The user measures diameter and total height of the diamond and enters them in 
Diamond Calculator, then fixes total depth with Lock button. After that, measuring the 
crown height and entering it into the software will cause an automatic adjustment of 
current pavilion depth and girdle thickness in such a way that the total height will not 
change. 
Parameter fixing is also very useful in diamond marking for maximizing the diamond 
mass with respect to restrictions imposed by a diamond with old cut, a semi-cut 
diamond, or a rough diamond. 
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Note. If a proportion allows a choice of units of millimeters or percents of diameter, 
only the value in percents will be fixed when Lock button is checked, even if a value 
in millimeters is displayed currently. 
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10 Selecting measurement units and parameters to show 
DiamCalc allows to choose the most convenient representation form or measurement 
units for some parameters. Diamond Calculator presents options of parameters' units 
of measurement, when applicable (e.g. linear size can be expressed in millimeters or as 
a percentage of the diameter). Another way to customize DiamCalc is to select one of 
several similar parameters. See examples below for more details. 

10.1 Selecting units of measurement 

By default, size parameters are presented as a ratio of the corresponding value to the 
diameter. In some situations, other units, e.g. millimeters, can be more useful. The user 
can choose measurement units for each particular parameter. 
 
To do this, point the mouse cursor to the 
parameter value and click right mouse 
button. A menu appears, allowing to see 
available units and select one of them:  
 
The menu above was produced by pointing the mouse to the value of «Total height» 
parameter and pressing the right mouse button. A check mark shows that the current 
unit of measurement is percents of the diameter. If «millimeters» is selected from the 
menu, a value will be recalculated and shown in a new format. 
When values of parameters are entered from the keyboard, units of measurement can 
be specified along with values. When a string like «1.1 %» or «0.02 mm» is typed, 
DiamCalc recognizes what is the value and what is the unit of measurement and 
change them if needed. If only a number is typed, DiamCalc applies the current unit of 
measurement. 
 

10.2 Dual parameters 

It is possible to use different presentations for some parameters. For instance, a 
slightly oval shape of the girdle can be described by two diameters, minimum and 
maximum. Alternatively, it can be specified by maximum diameter and deviation 
(brilliant cut) or ratio of maximum and minimum diameters (fancy cuts). 
 
To choose a presentation option of such a 
parameter, point the mouse cursor to the 
parameter's name and click right mouse 
button. A menu appears, allowing to 
select a presentation option:  
 
The picture above was taken when the mouse cursor was over «Sec. diameter» field 
and the right mouse button was pressed. As you see, a menu allows to select between 
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showing maximum and minimum diameters or just one diameter and ratio of 
diameters. 
There are other dual parameters: 

• Girdle square deviation <-> Alternative diameter (measured at direction 45°); 
• Star facet length <-> Table picture square-likeness. 

There is also a similar way to choose mass precision: 2 digits after decimal point <-> 4 
digits. 
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11 Importing/exporting external cut designs and diamond 
3D-models 

DiamCalc allows users to import cut designs and 3D-models of real stones generated 
with another software (note, this feature is available only for the registered users). This 
includes cut designs made with GemCad software and several other software and 
diamond 3D-models obtained with Sarin machines and OctoNus diamond scanners. If 
the model is convex you can adjust the size of the model, crown, pavilion and girdle 
heights, table and culet offsets and position of every facet. 

• The following file formats are supported, please read the next section for more 
information: 

• Gemcad ASCII format. You can design your own diamond shape or get one of 
the 3700 unique faceting designs form the DataVue2 library and see its 
appearance with the DiamCalc. 

• AutoDesk Drawing Exchange Format (DXF). This format is also popular and 
you can find cut design files in the Internet saved with this format. 

• OctoNus MMD format. File of this type contains 3D-model of the real stone 
that is built by OctoNus diamond scanners like Helium and Oxygen. For details 
about these products please visit our web-site: http://www.octonus.com 

• Sarin Web Viewer files (*.srn). File of this type contains 3D-model of the real 
stone that is built with several type of the Sarin machines.  

• Stereo Lithography (STL) format. DiamCalc supports ASCII and binary 
versions of this format. 

You can import model by choosing appropriate command in the menu Cut  Import 
Cut or you can simply drag and drop the file with the model into the DiamCalc 
window from Windows Explorer. 

11.1 Importing diamond 3D-model from Sarin Web Viewer file (*.srn) 

There are several ways you can receive .srn-files to your computer: 
• Sarin users, who own a DiaMension or DiaScan machine have a possibility to 

pack their information pertaining to a specific stone into a Sarin file (.srn). 
Please refer to Sarin web site to get information about the necessary software 
updates:  http://www.sarin.com/viewer/ 

• RapNet Members (www.diamonds.net) When 
searching for diamonds you may select the 
check «Display stones with Sarin data only» in 
the bottom of the Diamond Search Form. In the 
Search Results click on the «Sarin» picture in 
the desired row. You will be prompted to install 
Sarin Web Viewer. Once the Sarin Web is 
Viewer installed you will be presented with 
information about selected diamond: Click «Save…» button in the upper part of 
viewer. You will be notified about the name and location of the file saved. Keep 
in mind the file title in order to open it with the DiamCalc.  
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• Of course you can receive .srn files to your computer from your partners and 
friends via e-mail, on diskettes etc. 

In the DiamCalc use the menu command Cut  Import cut  From Sarin file 
You will be presented with «Open file» dialog allowing you to select file you want to 
import. 

 By default the initial folder is the folder where the Sarin Web Viewer saves 
downloaded files. If you want to change the default folder then modify the 
folder in the parameter «Sarin files folder» of the registry key: 
HKEY_CURRENT_USER\Software\OctoNus Software\DiamCalc\Settings 

Select the desired file and click «Open». If the model is imported successfully you can 
work with it as usual. It is assumed that the model in SRN file is convex. If the model 
is not convex, some of its parts may be cut off. 

11.2 Importing and exporting models from (to) DXF files 

In the DiamCalc use the menu command Cut  Import cut  From AutoDesk DXF 
file 
You will be presented with «Open file» dialog allowing you to select file you want to 
import. 

 The limited support of the DXF format is implemented in the DiamCalc (only 
«Mesh» type data is supported). This means that there is no guaranty that an 
arbitrary dxf file will be imported into the DiamCalc, but we successfully 
imported all diamond dxf-files we download from several sites. 

Select the desired file and click «Open». If the model is imported successfully you can 
work with it as usual. It is assumed that the model in DXF file is convex. If the model 
is not convex, some of its parts may be cut off. Here is the link to web- resource with a 
great number of downloads of free DXF cut models: www.3dlapidary.com 
With the menu command Cut  Export cut  To AutoDesk DXF file you can save 
any cutting you have in the DiamCalc (including imported models) to this format and 
then work with this file in the desired 3D software (AutoCad, 3Dstudio Max etc). 

11.3 Importing and exporting cut designs from (to) GemCad ASCII 
files 

In the DiamCalc use the menu command Cut  Import cut  From GemCad ASCII 
file 
You will be presented with «Open file» dialog allowing you to select file you want to 
import. Select the desired file and click «Open». If the model is imported successfully 
you can work with it as usual. It is assumed that the model in ASCII file is convex. 
With the menu command Cut  Export cut  To GemCad ASCII file you can save 
any cutting you have in the DiamCalc (including imported models) to this format and 
then work with this file in the GemCad software. 
Please note, that the coordinate system of GemCad does not match the coordinate 
system of DiamCalc. DiamCalc uses common right-hand coordinate system, while 
GemCad uses left-hand coordinate system. The X axis in DiamCalc goes to the right, 
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and Y axis goes up by default. Sides’ azimuths and indices are calculated from the X 
axis, so the side with zero azimuth appears on the right. 
Please also note, that GemCad software can't handle models that exceed the cube 
2x2x2 mm in size. It simply cuts off the model by such a cube. You may want to 
reduce the model diameter before export so that it fits a 2x2x2 mm cube. 

11.4 Importing and exporting models from (to) STL files 

In the DiamCalc use the menu command Cut  Import cut  From STL file 
You will be presented with «Open file» dialog allowing you to select file you want to 
import.  
Select the desired file and click «Open». If the model is imported successfully you can 
work with it as usual. It is assumed that the model in STL file is convex. If the model 
is not convex, the program will build convex hull of all vertices of the model. 
With the menu command Cut  Export cut  To binary STL file… and To ascii STL 
file… you can save any cutting you have in the DiamCalc (including imported models) 
to this format and then work with this file in the desired 3D software. 
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12 Adjusting shape of arbitrary imported 3D model of the 
diamond 

DiamCalc allows users to import cut designs and 3D-models of real stones generated 
with another software. When the new model is imported using Cut  Import cut menu 
DiamCalc analyzes it. If the model is convex, it may be adjusted. 

 
If the model is convex you can adjust the following parameters in the main window: 
diameter of the model, crown height, pavilion height, distance between crown and 
pavilion, table offset, culet offset. 
DiamCalc calculates 360 diameters of the model with the step of half a degree and 
takes the average value as the primary diameter. DiamCalc distinguishes crown, girdle 
and pavilion facets and remembers the type of each facet. Then it calculates the 
maximum height of the crown and pavilion as the difference between the highest and 
the lowest vertex among crown and pavilion facets respectively. It calculates the 
height of the whole model as well. The distance between crown and pavilion is the 
difference between the height of the whole model and heights of crown and pavilion. 
That is why, by the way, this distance may appear negative, if the highest vertex of 
pavilion is higher than the lowest vertex of the crown (assuming that crown itself is 
placed above pavilion). This may happen on real cuts. Thus DiamCalc calculates the 
minimum girdle height and maximum crown and pavilion heights. After the girdle is 
analyzed, the whole model is shifted along vertical (Z) axis to put its center of the 
mass in the center of the girdle. 
The values of table and culet offset parameters are not estimated during import of the 
model and they are always set to zero at first. Later you may adjust the offsets with 
these parameters. 
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Along with global model parameters like crown and pavilion heights that apply to the 
whole model, DiamCalc supports local parameters that allow to adjust each facet. 
Local parameters describe the deviations of each side from the whole model. These 
deviations do not depend on global parameters. Press the «Advanced» button on the 
tab with global parameters to open the window for detailed editing of the model. 
This window may show up to four views of the model. These views may be rotated 
(with left mouse button), shifted (with right mouse button) and scaled (with mouse 
wheel) synchronously and independently. All these transformations apply only to the 
position of the camera that shows the model from the main window, but they don’t 
change the position of the model itself. On the other hand, the rotation of the model in 
the main window changes its position, that is why it is reflected in all views. 

 
DiamCalc automatically divides all facets of the model into tiers, similarly to 
GemCad. The tier comprises facets with identical slope angle and distance parameters. 
The «Advanced» window shows the list of all tiers and 
the list of all facets within the tier. The facet selected in 
the list is highlighted on the model. The local parameters 
of the facet are slope angle, distance, azimuth angle (or 
gear index). The advanced window allows adjusting of 
the facet position by adjusting its parameters. 
DiamCalc shows deviations of these parameters from 
initial model as well as the resulting values. When you alter the position of facets the 
model on the screen is changed instantly, but the global parameters are not 
recalculated. In order to change the initial model permanently, use the «Apply» button. 
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It will substitute the initial model with the current model and all global parameters will 
be recalculated from a scratch. You may discard the changes in local parameters by the 
«Discard» button. This will reset the position of all facets and zero all local 
parameters. 
It is not recommended to adjust global and local parameters simultaneously, because 
local parameters describe absolute deviation of the facet from the current model. If you 
change the whole model via global parameter, these deviations will become incorrect, 
which will result in incorrect model shape. 
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13 Visual presentation of a diamond 
DiamCalc supports different types of visual presentation of diamonds, allowing to 
produce realistic views of a stone. 
DiamCalc supports several different types of diamond images. A diamond can be seen 
from different angles or even from two different positions simultaneously. Each 
diamond view can be further customized to produce even better visual impression. 

13.1 Model types (wireframe and rendering modes) 

An image of the diamond is displayed in the left part of DiamCalc main window. 
Depending on purpose, various types of the model image can be used: 

Draft mode (wireframe) 

This mode shows the diamond as a three-dimensional framework. 
Visible and invisible edges are seen as solid and dashed lines, 
respectively. Facets are now drawn, color and illumination is not 
taken into account. This option is useful for the visual determination 
of proportions. This mode is the default one. 
To select Draft mode when another model type is currently chosen, 
use Draft command from  Options  Model type menu. 

Draft modes with reflection 

These modes are similar to the previous option, but they also show 
which edges and facets would be seen through the diamond surface 
with regard to edge refraction and reflection. There are two modes 
in this category: «Draft + reflection» and «Draft + double 
reflection». The difference between them is that they take into 
account one or two reflections of the light, respectively. 
To set one of draft modes with reflection and refraction, select 
«Draft + reflection» or «Draft + double reflection» commands from Options  Model 
type menu. 

Photoreal mode (rendering mode) 

This mode simulates the real diamond under certain lighting 
conditions and considering the particular properties of a diamond 
specimen. Sometimes, a photoreal image is very similar to the 
photograph of the real diamond. From this image, one can judge 
about the appearance of the polished diamond and select unknown 
parameters by comparison of the real diamond to the computer 
model. 
To select Draft mode, use Draft command from  Options  Model type menu. 
Note. All models except Draft (especially «photoreal» mode) require significant 
calculating power, so images can be slow to redraw on less powerful computer 
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systems. At least Pentium II, Celeron or comparable processor is recommended. All 
types of models can be seen on a slower system as well, but you may experience a 
significant delay when the image is redrawn. In these cases, it is recommended to set 
Draft model type, change all parameters you want to modify, rotate the diamond to the 
position that you want to inspect, and set a view mode other than Draft only then. With 
this method, only one slow redrawing is required and you avoid delays after each 
change of diamond parameters and position. 
Note. A pair of stereo glasses (one with red filter for the left eye and blue filter for the 
right eye) is required to view model in Red-Blue Stereo mode. Without such glasses, 
the image in Stereo mode cannot be seen meaningfully. 

13.2 Setting diamond position 

 
DiamCalc allows to easily reposition the 
diamond with the mouse to view it from a 
different angle. To do this, press the left 
mouse button anywhere on the model. 
Note the position of the mouse cursor 
above - it is the place where mouse button 
was pressed. 

 
To move the diamond, simply move the 
mouse in the direction where you want to 
rotate it, holding the button. After 
diamond is moved to the desired position, 
release mouse button. On the screenshot 
below, mouse cursor is where the button 
was released:  
 
As you see, moving the mouse in vertical direction looks like «dragging» the diamond 
around horizontal axis. Moving the mouse in another direction would cause a different 
rotation. Such operation can be repeated, and the diamond can be set to any position 
after several steps. 
There is another tool for moving the diamond: the movement panel. It can be called by 
Movement panel command in View menu. The movement panel allows to specify by 
which angle the diamond should be rotated, and perform the rotation by one of six 
buttons (one for each direction). 
Use mouse wheel to change the scale of the diamond. 
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13.3 Setting one or two simultaneous views of a diamond 

DiamCalc can show two simultaneous views of the same diamond taken from different 
angles. To do this, use Split command in View menu. A horizontal bar will appear, 
letting to split the diamond image into two panes. 
When there are two images, each one can be tuned separately: e.g. one can hold a 
frame model of the diamond and the other view can be a photoreal model. 
A split line between two models can be moved at any time by mouse, changing sizes 
of the images. Also, two images can be converted back to a singe one by moving the 
split line to the top or to the bottom, decreasing the size of one image to zero. 

13.4 Selection of a light source 

DiamCalc can imitate various light sources. This option is available for Photoreal 
model type only, as Draft model types do not take illumination into account. 
To changes a type of lighting, use Options-Lighting menu, and then select a desired 
type. The following common types of lighting may be turned on in the photoreal 
mode: 

• «Dialite» - One scattered light source located above the diamond. 
• «Jewelry Shop» - The main scattered light source above the diamond and 

several auxiliary point sources directed from different sides. 
• «Disco» 
• «Office» - Lighting similar to office. 
• «Incandescent lamp» 

The Options  Special View menu contains a list of special lightings. 
The DiamCalc also gives you a possibility to adjust the lighting with the 
«Customize...» option of the light menu. Select this option and you will be presented 
with the panel that allows you to configure number of sources, location, size, 
brightness and other characteristics of each light source. 
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14 Cut Quality Estimation 

14.1 Leakage of Light in Diamonds and Its Estimation 

In a diamond, there are some regions that do not return light towards the observer's 
eye. If we trace those rays connecting the eye with the regions that show no brilliance, 
we'll find out that some of these rays leave the diamond through its crown but do not 
propagate towards the source of illumination. Another portion of these rays leaves the 
diamond through its pavilion, giving rise to the phenomenon called leakage. The third 
portion of these rays becomes screened by the observer's head or body, giving rise to 
the effect known as NailHead. 
All the three effects cause the observer to see dark, non-illuminated regions in the 
diamond. Analyzing the leakage and the NailHead effect allows one to reveal such 
regions of the diamond, which are dark regardless of the type of illumination. It is 
especially important to determine the parameters of the diamond, for which these dark 
regions combine into large zones. In such a case, the observer easily notices an abrupt 
decrease in the local contrast.  
It is possible to observe the regions of leakage by placing the diamond into a Firescope 
that illuminates the stone with white light from the side of its pavilion. 
 

  
  

Photo made with the Firescope Model of the same diamond, using 
illumination of the Firescope type 

 
White regions can be seen here and there. Therefore, a light ray passes through these 
regions from under the diamond to the observer's eye. If such a diamond was mounted 
into a jewel, we would see the mounting through these regions and would never see 
any light originating from the illumination source. Therefore, the more leakage regions 
the diamond contains (and the stronger the leakage effect), the fewer the regions of the 
diamond, capable of reflecting the illumination into the observer's eye, and the worse 
the cut quality of the stone.  
Theoretically, it is possible to imagine such a location of the illumination source, from 
which a light ray enters the diamond and splits into multiple rays there, some of these 
leaving the diamond towards the observer's eye. However, these rays can be only 
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secondary (not primary) ones, which are either quenched due to polishing or become 
so weak upon leaving the stone that the observer will not perceive them as bright light. 
 

  
  

Ray path through a white region Ray path through a gray region 
 
Besides the white regions, it is possible to notice some gray regions in the stone 
observed. These regions show partial leakage of light. In other words, some rays leave 
the diamond through its pavilion, while the other ones leave it through the crown. If a 
ray originating from the illumination source passes through such a region, the partial 
leakage attenuates the ray and only a portion of the original ray reaches the observer's 
eye. This can be demonstrated by tracing the ray as it passes through the white and 
gray regions: 
 

  
  

Ray path through a white region Ray path through a gray region 
 
To reveal those dark regions caused by light leakage, that is, the regions, which remain 
dark upon arbitrary daylight illumination of a collet-set stone a model of Leakage-type 
illumination has been built. The model is a hemisphere located below the pavilion of 
the diamond and extends up to the girdle plane (upper edge of the girdle). Thus, the 
model takes into account those rays leaving the stone through its pavilion or girdle. 
Those zones of the diamond looking bright upon the Leakage-type illumination will be 
dark upon usual illumination. 
To some extent, this kind of illumination is similar to the illumination from below, 
used in the Firescope. The main difference between these is the fact that the Leakage-
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type illumination reveals only light leakage. Therefore, those regions of the stone 
looking pink under the Firescope illumination are gray under the Leakage-type 
illumination. 
 

  
  

Firescope-type illumination Leakage-type illumination 
 
In order to analyze the cut quality of the diamond and the accuracy of its proportions, 
it is reasonable to quantitatively estimate the leakage of light. We propose the 
following way of doing that. The leakage is estimated as the subjective brightness of 
light that returns to the observer's eye in the case when the illumination of the diamond 
is of the Leakage type. Here we use a model of photo objective (diameter 150 mm, 
distance to diamond 60 cm) as a viewer. Here we not take into account human 
stereoview. We suggest calling this viewer a «Photoreceptor». 
Since there are some stones that show considerable leakage primarily through the 
table, we calculated two leakage types: through the whole crown of the diamond (plot 
1) and through the table solely (plot 2). Those portions of the plots characterized by 
large leakage values represent undesirable proportions of the stone, that is, those cut 
parameters causing considerable leakage of light either through the crown or through 
the table. 
When analyzing these plots, it turns out that they are quite similar to plots of 
diamond's Light Return. This fact is absolutely reasonable, because the Light Return 
through the crown and the light leakage through the pavilion should be interrelated. At 
the same time, some differences can be noticed, the most interesting one 
corresponding to the region close to the Tolkowsky's cut parameters (slightly upper on 
the plot than these). This region looks good from the point of view of Light Return but 
much worse from the point of view of light leakage. When studying gems belonging to 
this cut parameter range, one can notice that their Light Return is high only in the 
«crown looks to the observer» position. When swinging such a stone, its Light Return 
appears to be lower than that of a diamond cut in accordance with the Tolkowsky's 
parameters. 
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Plot 1. Light leakage through the crown of a round brilliant cut diamond with a table spread of 
57% and a girdle thickness of 1% as a function of the crown angle and the pavilion angle. The 
distance between the photoreceptor and the diamond is 60 cm. The plot is based on the image 
observed by photoreceptor. The diamond is oriented so that the table looks towards the 
observer. The larger the leakage value plotted, the stronger the leakage effect and the lower the 
quality of the diamond. 
 

 
 
Plot 2. Light leakage through the table of a round brilliant cut diamond with a table spread of 57% and 
a girdle thickness of 1% as a function of the crown angle and the pavilion angle. The distance between 
the photoreceptor and the diamond is 60 cm. The plot is based on the image observed by the 
photoreceptor. The diamond is oriented so that the table looks towards the observer. The larger the 
leakage value plotted, the stronger the leakage effect and the lower the quality of the diamond. 
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Plot 3. Adapted leakage calculated for the table of a round brilliant cut diamond with a table 
spread of 57%. The position of the stone is static; photoreceptor. 
 

 
Plot 4. Adapted leakage calculated for the crown of a round brilliant cut diamond with a table 
spread of 57%. The position of the stone is static; photoreceptor. 
 
When studying the effect of light leakage, an inversion function was introduced, which 
is required to adequately take into account the leakage during the geometric averaging. 
So, the stronger the leakage, the smaller the leakage measure supplied to the averaging 
procedure. Only in this case the geometrical averaging will cull out those stones 
showing strong leakage of light. Another purpose of using the inversion function is 
correct normalization of the leakage value with respect to the Tolkowsky's cut 
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parameters. The leakage value for these parameters should be 1. Otherwise, a 
mismatch arises between modeling light return and other effects, violating the resultant 
brilliance function that takes into account both the brilliance and effects. 
We propose to refer to the value of leakage, obtained with the use of the subjective 
grading and inversion functions, as the adapted leakage. 

14.2 Stereoview: Stereovision and evaluation of leakage 

The human nature of seeing is stereoscopic. When we look at an object by two eyes, 
each eye sees its own picture, and these pictures are different one from another. 
 

   
   

The flat image of a diamond in 
the «fase-up» position. This is 

the way as a photocamera 
«sees» 

The same diamond observed 
by the left eye 

The same diamond observed 
by the right eye 

 
Human brain transforms two pictures into stereoscopic one. How does it happen? Is it 
correct that the brain observes the same picture as the photocamera does? Actually 
work of the brain on the creating of one stereoscopic image from two initial ones is not 
a simple averaging of two pictures. The image in the brain can be absolutely different 
from the average picture seen by the right and left eye correspondingly as well as from 
the image seen by the «photoreceptor» where the image is the result of observation 
along one direction.  
Considering this phenomenon in application to the leakage of light in diamonds, we 
face the task how to evaluate areas in diamonds, in which one eye sees the leakage and 
the other eye does not. In other words what will be in the human brain when one eye 
observes the white area while the other eye sees the dark one. In this case the human 
brain will see the white area. When at least one eye sees leakage then the resulting 
image is also persepted as leakage. For the white background the situation is opposite - 
the brain feels the black section as the result of superpositioning two pictures.  
Another consideration is the case of partial leakage areas in a diamond. On the figures 
shown below there's a partial leakage under the table seen by the right and by the left 
eye correspondingly in the «Leakage» model of illumination: 
Human brain transforms two pictures into stereoscopic one. How does it happen? Is it 
correct that the brain observes the same picture as the photocamera does? Actually 
work of the brain on the creating of one stereoscopic image from two initial ones is not 
a simple averaging of two pictures. The image in the brain can be absolutely different 
from the average picture seen by the right and left eye correspondingly as well as from 
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the image seen by the «photoreceptor» where the image is the result of observation 
along one direction. 
Considering this phenomenon in application to the leakage of light in diamonds, we 
face the task how to evaluate areas in diamonds, in which one eye sees the leakage and 
the other eye does not. In other words what will be in the human brain when one eye 
observes the white area while the other eye sees the dark one. In this case the human 
brain will see the white area. When at least one eye sees leakage then the resulting 
image is also persepted as leakage. For the white background the situation is opposite - 
the brain feels the black section as the result of superpositioning two pictures.  
Another consideration is the case of partial leakage areas in a diamond. On the figures 
shown below there's a partial leakage under the table seen by the right and by the left 
eye correspondingly in the «Leakage» model of illumination: 
 

  
  

Picture for the left eye in the «Leakage» 
illumination 

Picture for the right eye in the «Leakage» 
illumination 

 

  
  

The average picture: week partial leakage 
under the table 

The result of stereo effect calculation: 
moderate leakage under the table 

 
Literally all the modern conceptions of the diamond cut investigations will bring to the 
conclusion that the result leakage through the table is negligible for this diamond. It 
can be shown in the Firescope or in the «Leakage» illumination for the average 
position of the stone. 
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Taking into account stereovision effect lets us conclude that the result leakage seen by 
the brain through the table will be more considerable: 
These examples show the work of stereo mode applied in this software. It evaluates 
the leakage of light from the point of view the real observer - the human head with 
stereovision. 

14.3 Taking into account the features of human perception 

The necessity of taking into account the psychophysiological factors of human 
perception of the appearance of a diamond has changed the modeling methods used in 
gemological studies. In particular, a number of special functions, such as subjective 
brightness, subjective grading, and weighed geometric average, have been introduced. 

Subjective brightness function 

If an observer is provided with a number of grayscale color samples and asked to 
select such a gray tone that equally differs from white and from black, he faces a 
considerable difficulty, because estimating the relative value of two considerable color 
differences is based solely on a subjective impression. However, the required gray tone 
can be determined by averaging the subjective estimations of a few observers. Then, 
the same method can be applied to the two color ranges obtained (the first is from 
black to middle-gray; the second is from middle-gray to white). As a result, a uniform-
contrast scale of luminosity (subjective brightness) can be built. This was one of the 
methods used to define a grayscale in Munsell's color space. One of the first formulas 
to determine this scale was the square root of the brightness (intensity), It is 
worth noting that a power law is suitable not only for defining subjective visual scales, 
but also for describing the human perception of sound intensity and some other 
characteristics. In other words, to make the human perception twice stronger, the 
intensity of the external action should be increased 4 times. In 1964 CIE approved a 
cube root formula, which well fits the Munsell's square-root luminosity 
scale for Y ranging from 1 to 100. These formulas do not take into account adaptation 
of the observer's eye to the background. At the same time, the background level 
strongly affects the subjective brightness of an object. You may feel it by comparing 
two gray squares of the same intensity, surrounded by a black and a white background. 
On the basis of experimental results obtained by Kaneko, Takanashi, and Semmelroth, 
it has been shown that the following formulas are more adequate for calculating the 
subjective brightness of an object, depending on the background level: 
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where V is the subjective brightness (or luminosity) of 
the object; Y is the intensity (luminance) of the object; 
YBG is the intensity (luminance) of the background that 

surround the object; m, n, and k are coefficients that determine the relative 
contributions of human stimuli. It is empirical fact that the most appropriate values of 
the latter coefficients are the following: m=0.4, n=0.2, and k=0.65. 
We used a slightly modified version of the above formulas to estimate the brilliance of 
a diamond and leakage of light in it. 

Subjective grading function 

People usually grade various phenomena using a discrete set of categories (such as 
«bad», «good», «perfect», etc.) rather than percent scale or another continuous 
measure. It can be said that people have natural bias towards discrete grading of 
phenomena, even if the physical characteristics of these phenomena change 
continuously. That's why we have introduced a so-called three-step Grading Sigmoid 
as a measure of human rating of phenomena studied. The conventional sigmoid 
function often used in mathematics (see the plot below) represents only two levels, 
while people use at least three levels to grade events. So, we had to slightly generalize 
the sigmoid function for our purposes. 
 

 

 

Weighed geometric average function 

When modeling a grading procedure of a cut diamond, it is not enough to take into 
account only a single static position of the stone. This is because a real observer would 
view the diamond from different sides. Therefore, we performed all the necessary 
computations for 15 orientations of the stone (it was rotated by 30 degrees around its 
axis) and then used weighed geometric averaging. The latter procedure reflects human 
perception more adequately than arithmetical averaging does. The geometrical 
averaging takes into account two key features of human perception.  
The first feature is highlighting some bad views of the stone under study. This means 
that if the observer notices a bad perspective while changing the stone orientation, the 
negative impression may last even after the perspective is changed to a more 
advantageous one. The human perception tends to grade this stone as bad. So, the 
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geometric averaging makes it possible to adequately grade those stones looking bad in 
some orientations and prevents the negative rating from being compensated by 
advantageous perspectives. Such compensation may easily occur if one uses 
arithmetical averaging. 
The second key feature of human perception is that when grading a stone the observer 
pay more attention to the «crown up» position. The larger the deviation of the stone 
orientation from the position when the crown looks exactly towards the observer, the 
less the «subjective weight» of this orientation in overall grading. Therefore, we made 
the geometric averaging weighed by taking into account the deviation angle of the 
diamond from the «crown towards the observer» orientation. The resultant averaging 
function looked as follows: 

 

14.4 Brilliance 

Below there are all definitions of «Brilliance» that we could find so far (1), our 
considerations why so many definitions do exist (2), and two definitions of 
«Brilliance» that match our understanding of this phenomenon (3). This material is a 
part of our future article devoted to Brilliance and we will be grateful if you share your 
considerations, concerns and comments.  

Definitions of «Brilliance»  

• GIA Diamond Dictionary, 3rd edition: Intensity of the internal and external 
reflections of white light from the crown of a polished diamond or other 
gemstone. Hardness, refractive index, reflectivity, polish, luster, and 
proportions all affect a gemstone's brilliance.  

• Diamond Grading ABC by V. Pagel-Theisen, 11th edition: External brilliance - 
luster, produced by reflection of light on the surface of the facets; Internal 
brilliance - refraction and total reflection of light on the pavilion facets; 
Dispersive brilliance - splitting of scattering of light into its spectral colors = 
the dispersion which evokes the «fire» or «life» in a brilliant; Scintillation 
brilliance - the «sparkle» of the stone when moved, caused by light reflections 
of the light source.  

• Dodson's definition (1978): A measure of the light that, entering the crown of 
the stone, is scattered out of the crown facets.  

• «Professional Jeweler» (July 1998) Light Return/Brilliance. The amount of 
light returned to the eye, or brilliance, depends on how well the diamond in 
question reflects and refracts light. This includes dispersed wavelengths, which 
are reflected from the internal surfaces of a diamond and returned to the eye.  
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• http://www.pricescope.com: Brilliance is the most important feature of a 
beautiful diamond. At the simplest level, brilliance is reduced if light leaks out 
the back of a diamond. In a more complex analysis, the direction that light 
enters and leaves the top of a diamond becomes very important. A very deep 
pavilion diamond returns light straight back to the viewer, so in fact when you 
look face onto the table your head blocks the light and the diamond looks dull. 
Some diamonds that are too shallow suffer a similar problem (with a different 
cause). 

Discussion  

It is well know in gemology and trade that the diamond appearance is described in 
terms of Brilliance, Scintillation and Fire. These three parts describe the diamond 
appearance completely. 
Literature review and comparison of trade opinions show that the «Brilliance» term is 
not clearly defined and there is no one generally accepted definition. 
Probably about 50 years ago the word «Brilliance» was used as ultimate description of 
the diamond appearance. At that time it was a synonymous with «Beauty». Evolution 
of ideas was leaded to separation of «Fire» as a characteristic of colored part of 
Brilliance and after that to separation of «Scintillation» what characterized a moving 
diamond. All that remained after separation of these two properties is known today as 
«Brilliance». 
At present time there are three different ideas of brilliance: 
 

1. Diamond beauty (as 50 years ago); 
2. Diamond beauty minus Scintillation minus Fire; 
3. Light Return (sometimes including external luster or sometimes taking into 

account internal reflections only). 

Here we are posting two following definitions of «Brilliance» for your 
suggestions 

First definition 
Brilliance is the characteristic of a diamond, which remains when we «take» all its 
appearance and «subtract» Scintillation and Fire. The human eye will see Brilliance as 
combination of white, gray and black zones for motionless diamond ( i.e. colored 
zones are eliminated). 

Second definition 
The phenomenon called Brilliance consists of two parts. The first one is based on 
comprehension of primary/initial/incipient brightness and contrast of diamond image 
(motionless photo-shots taken from different positions). The second part consists of 
posterior/subsequent traditional comprehension of some phenomena as negative or 
positive (like «Fish-Eye», «Nail Head», «Leakage», thick girdle, symmetry deviations, 
Tolkovsky pattern, «Ideal Cut»). 
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This second part appeared due to attempts to grade the first part of Brilliance and to 
interpret it by viewing many diamonds. And nowadays the members of the 
contemporary market have in their memory a set of standard images, which people 
have already associated with positive or negative emotions. 
Perhaps to evaluate Brilliance objectively the first part would be well enough, but it 
would not be enough for a human subjective evaluation because a human mind could 
hardly grade/calibrate it. It is easier for a human brain to grade/evaluate Fire of 
Scintillation because under fixed illumination conditions one can easily count «two 
flashes» or «four bright sparkles during motion» or «no one colored facet». Seemingly 
the attempt to replace «Brilliance» by «Light Return» is bound up with the very need 
to grade. 
Comprehension of the first part of Brilliance depends on sex and age of people. 
Comprehension of the second part of Brilliance depends on the environment/culture 
where people grow. As a consequence the comprehension of the second part of 
Brilliance will vary for different nations, times, social groups, etc. This phenomenon is 
similar to tastes (like preferences of types of clothes, vine, women, men, cars, books 
.... etc). 

14.5 Light Return  

In the Diamond Cut Study the light return was measured under different lighting 
conditions. However, this takes a lot of time. In this Gem Adviser demo the light 
return is computed for single lighting. 
To learn how the specific of the human perception is considered in Light Return 
estimation please read this article: 
Taking into account the features of human perception 
To learn more about the difference between «mono» and «stereo» modes please read 
this article: 
Stereoview: Stereovision and evaluation of leakage 
To read more about the Light Return please refer to the following materials: 
Diamond cut study on www.cutstudy.com 

14.6 Contrast 

This is an estimate of subjective perception of diamond’s picture in some lighting 
surround by a human eye, namely is the image more or less “contrast”. It is essentially 
the cumulative length of visible borders between differently colored zones on the 
image multiplied by differences across these borders both in brightness and 
chromaticity. Additional reduction of contrast is introduced to take into account the 
low-contrast perception of very small details of an image such as very small virtual 
facets that have no potential for our eyes to resolve sparkles or contrasting zones. 

14.7 Dark Zone 

Dark Zone is an estimate of size and the negative effect of dark zones seen within a 
diamond. Dark Zones occur when we see parts of a diamond where we cannot see any 

http://www.octonus.com/oct/products/3dcalc/standard/perception.phtml
http://127.0.0.1/oct/products/3dcalc/standard/stereoview.phtml
http://www.cutstudy.com/
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brighter lights in the surrounding space around the diamond. This part of space is 
essentially when we can see through to the pavilion-side hemisphere, and the space 
occupied by implied observer’s head and body. The lower the Dark Zone number of a 
diamond the more probably it will look dark or have unattractive area for a typical 
observer. Very small and frequent Dark Zones contribute to contrast, very large dark 
zones detract. 
 

14.8 Fish Eye 

Fish Eye is a reflection of the girdle on the pavilion facets visible in the face-up 
examination of a diamond with a very small pavilion angle. It is one of the optical 
effects like Kozibe, Nail Head and etc. For example a round brilliant that needs more 
than 5º of tilt to see the girdle will be graded Very Good 1.00, and if the tilt is more 
than 0.1º and less than 5º it will be graded as Good 0.75. Less tilt than 0.1º receives 
Poor 0.50. 

14.9 ETAS 

ETAS (Effective Total Angular Size of a diamond) is an estimate of the probability for 
a small light source to be seen through the diamond  
Fire is an estimate of probability for colored dispersed light to be seen due to 
chromatic dispersion of the light source caused by the crystal.  
DETAS (Dynamic ETAS) is an estimate related to ETAS but it considers a diamond in 
motion, namely being tilted to small angles. While tilting, a diamond “scans” the space 
around it, thus increasing the probability to see a light source.  
ETAS, Fire and DETAS are all compared to a 6mm diameter Tolkowsky diamond. 
 
 

http://www.cutstudy.com/cut/english/comp/kozibe.html
http://www.cutstudy.com/cut/english/comp/kozibe.html
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15 Working with the different types of gemstones 
DiamCalc allows to work not just with diamonds but also perform the calculations and 
get photo-realistic images of the different gemstones, like emerald, CZ, etc. The 
3Dcalc users have the opportunity to change manually gem material characteristics 
according to external information available about a certain stone. Lately user can work 
with the adjusted material characters by loading them from saved and collected files. 

15.1 Select the type of gemstone 

The menu command «Gem» presents you with the list of «built-in» types of 
gemstones. For the time being the following built-in materials are available: colorless 
diamond, emerald (2 types), CZ. 

15.2 Adjust the gem material characteristics 

The menu command «Gem/Properties» presents you with the panel to adjust gem 
characteristics (in the demo version it works in the read-only mode). 
The «General» tab allows you to define the material density and select if the gem is 
colored of colorless. 
 
The menu command «Gem/Properties» 
presents you with the panel to adjust gem 
characteristics (in the demo version it 
works in the read-only mode). 
The «General» tab allows you to define 
the material density and select if the gem 
is colored of colorless. 

 
 
The «Refraction» tab allows you to adjust gem refraction. The most right way to adjust 
the refraction to simulate specific gem is to input the RI value at each wavelength 
using the «spectrum» grid (see picture below). When you change just the «refraction» 
parameter then the arithmetical difference you want to supply is added to all RI values 
in the spectra. The dispersion in this case isn't changed. This allows you to adjust 
quickly and conveniently gem properties for groups of analogous materials that has 
almost the same dispersion and different RI. If you haven't whole-spectum RI data 
then you may approximate required RI values basing on a couple of values you have. 
After pressing «Adjust manually...» button you can supply arbitrary RI and dispersion 
values and the DiamCalc will make the linear approximation to meet the specified 
requirements. The button «Select from list…» presents you with a list of (RI and 
dispersion) pairs corresponding to most gem materials. However, by selecting the 
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desired gem material type from this menu you affect only the refractive features of the 
material, but the absorption and specific gravity stay unchanged after this action. 
The «absorption» tab (for colored gems) has the same structure as «refraction» tab. It 
displays the spectrum of absorption on a diagram and allows you to modify it. The 
absorption values must be adjusted for 1mm thickness. 

15.3 Natural Diamond and Cubic Zirconia in the list of materials for 
setting refraction in Gem properties 

Open panel Gem properties from menu Gem Material -> View / Modify properties… 
Press button Select from list… The panel Gem material list will open. Where you can 
find new materials. 

 

15.4 Visible adsorption spectra and DiamCalc-files of colored gem 
materials 

Download it from our web-site: 
http://www.octonus.com/oct/projects/adsorbtion_spectra.phtml 
 

http://www.octonus.com/oct/projects/adsorbtion_spectra.phtml
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16 Appraising diamonds quality and pricing diamonds 
OctoNus Diamond Calculator has two major features that help to evaluate diamonds: 

• Appraising diamond quality and quality of particular diamond parameters 
(girdle size, pavilion angle, etc.) 

• Pricing diamonds basing on price lists with discounts for diamond shape, cu 
quality, color and clarity 

By default, the DiamCalc does not display price. To enable or disable price display use 
menu command View  Prices 
There are several built-in systems of diamond grading («appraisers»): AGS, HRD, 
GIA, AGA and Russian TU. Moreover, the data of appraisers is stored as a text and 
can be edited, so you can change criteria of appraising diamonds or even add your own 
grading scheme. 
Price lists are also stored as a text, so they can be customized, including possible 
discounts for diamond shape, color and clarity. Also, there is a free DBFCONV utility 
which provides a way to use Rapaport price lists with Diamond Calculator. 
DISCLAIMER. The numerical representation of grading systems used by DiamCalc 
is not an official data of the corresponding bodies. Although the data was intended to 
describe HRD, GIA, AGA and Russian TU grading systems as precise as possible, 
some ambiguities or differences with the official data might exist. OctoNus Software 
recommends that you check appraiser data and modify it as necessary before using it 
to grade diamonds for commercial purposes.  
DISCLAIMER. The price lists supplied with DiamCalc are sample ones. Although 
they are similar to real price lists used in the diamond industry, OctoNus Software 
does not guarantee that you can buy or sell diamonds at the price that was calculated 
by DiamCalc on the basis of the supplied price lists. OctoNus Software recommends 
that you verify price list data and modify it as necessary before using them for 
appraising diamonds for commercial purposes. 
You can see «How DiamCalc grades diamonds» for exact criteria of diamond grading 
provided by DiamCalc. 
«How DiamCalc prices diamonds» explains how the price is calculated depending on 
diamond color, clarity, shape and other parameters. 

16.1 How DiamCalc grades diamonds 

When a diamond data is entered, DiamCalc uses a selected grading system 
(«appraiser») to grade each diamond parameter according to tables below. Depending 
on parameter value, it is given a grade (different grading systems have different quality 
groups). Then the quality of the diamond cut is calculated as the worst of quality 
groups of all individual parameters.  
This data is contained in Appraise.txt file in the folder where DiamCalc is installed. 
There are two kinds of data tables: appraiser tables and translation tables. 
Appraiser tables shows how each individual parameter is graded. They contain 
following columns: parameter name, as it is listed in Appraise.txt file; the meaning of 
the parameter; and one column that lists a range of that parameter for each quality 
group. 
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Translation tables give a numerical equivalent for quality groups of some parameters, 
for instance, they could define a «thick» girdle as having size between 4.75 and 6.25 
percents of the diameter. 
Tables are ordered by grading system, then by cut. The following systems and cuts are 
implemented: 

• HRD system: Brilliant cut; 
• GIA system: Brilliant cut; 
• AGA system: Brilliant (different tables for diamonds less than 0.5 ct or 0.5 ct. 

and more), Pear, Heart, Oval, Marquise, Prince, Emerald and Radiant. 

16.2 How DiamCalc prices diamonds 

DiamCalc can estimate a price of the diamond taking into account the mass of the 
diamond, its cut, color, clarity, quality of cut and a user-defined discount. 
The following method is used: 

• Base price per carat is calculated with price lists using mass group, cut, color 
and clarity. 

• A discount for cut quality is taken (cut quality is determined by «DiamCalc 
Appraisers Description»). 

• The final price is calculated on the basis of base price per carat, mass, discount 
for quality of cut and user discount. 

Price lists are stored in text files. The main file is Price.txt which is located in the 
folder where DiamCalc is installed. The shipped version of Price.txt file does not 
contain price lists itself, but rather has references to OctBrill.txt file (it is located in the 
System subfolder and lists prices for Brilliant cut) and OctPear.txt file (it is also in 
System subfolder and contains prices for Pear cut). 
Price.txt file also specifies that the price for diamonds of other shapes is a half of the 
price of the Brilliant cut diamonds with similar other parameters. For the details of 
individual file formats, see the links below. Note that there are three price list files in 
the shipped version of the software (Price.txt, System\OctBrill.txt and 
System\OctPear.txt), but formats of the last two are essentially the same. 



109 
 

 

 
  
 

17 Creating diamond reports 

17.1 Creating a Diamond Grading Report 

 
Diamond Calculator can create a diamond 
grading report. This feature requires that 
MS Word 95, MS Word 97 or later is 
installed. To create a report select in menu 
command File  Report (Export to 
Word)…. MS Word will be started, and a 
new document created. You can view the 
report or print it from Word as usual. A 
report describes cut, proportions and 
contains a schematic image of the 
diamond: 

 

17.2 Creating reports for scanned polished diamonds 

 
The OctoNus Helium software can export 
a 3D model of the scanned diamond and 
its parameters to the DiamCalc’s DMC 
file. DiamCalc can read such files and 
display the scanned model and its 
parameters. DiamCalc can generate the 
same reports on scanned diamond as 
Helium does using the data provided by 
the Helium. For more information about 
Helium please visit our web-site at 
http://www.octonus.com/oct/products/. 
If the loaded file contains the scanned 
diamond parameters, some of them will 
be displayed on the «Advanced» and 
«Advanced 2» tabs: 
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When you work with scanned or imported 3D model a special button «Scanned 
reports» becomes enabled. This button is located to the right of parameters list. It 
invokes a new window that allows creating reports for 3D models of diamonds 
obtained by OctoNus scanners as well as for any other imported 3D model. The 
DiamCalc installation contains a set of sample stones with different cuttings scanned 
on Helium. They are placed in the SAMPLE_STONES subfolder. 
If you loaded the DMC file that was created by Helium, the window for reports will 
look similar to this: 

 
 
The cutting type of the model is already defined; all facets of the model are colored 
according to their types. Generally you will not need to alter these. You may adjust 
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extra parameters like «Model name». In order to make a report choose report template 
from the list and press the «Make report» button. RTF reports require MS Word to be 
installed. If you choose report from «Open RTF» tab the DiamCalc will fill the chosen 
template with report parameters and pictures and launch MS Word. If you choose 
report from «Print RTF» tab the filled report will be sent to default printer and MS 
Word will close. Reports from «Open HTML» tab will be shown in your default 
browser. 
If you imported 3D model or loaded DMC file that doesn’t have report data yet, the 
window for reports will look similar to this: 
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At first specify correct cutting using drop-down list. Please note, that there are 
different sets of report templates for different cuttings. The list on the screen will show 
templates available for the selected cutting. Then you will need to specify types of 
each facet so that the software will be able to calculate stone parameters. Check the 
«Edit facet types» checkbox. If it is the first time when you begin to edit facet types on 
this stone the DiamCalc will try to detect facet types automatically (the same is done 
when you press the «Run auto detection now» button). Verify that all facets are 
colored correctly and adjust colors where necessary. Refer to sample stones included 
with DiamCalc to see how different cuttings should be colored. 
In the window with the model left mouse button rotates the model, right mouse button 
moves the model, mouse wheel changes zoom. In the edit mode (when «Edit facet 
types» is checked) use the table of colors to choose the facet type. Press left mouse 
button on the facet and its type will be changed to the currently selected. Press right 
mouse button on the facet and the currently selected color will switch to the color of 
this facet. Color boxes in the table show the quantity of facets of the given type. It may 
be useful as a quick check, e.g. it is known that the full round brilliant cut should have 
8 main facets and 16 halves. 
Once you specified types of all facets enter values for extra parameters that you need 
and press «Calculate report parameters button». DiamCalc will measure stone 
parameters based on the Cutting type and facet types that you provided. In order to see 
the result, choose report template from the list and press the «Make report» button. 

 For more detailed step-by-step instruction of making report for a model 
obtained by Sarin scanner see DiamCalc Howto document section «Make 
report for a model obtained by Sarin scanner» or visit internet page 

http://www.octonus.com/oct/products/3dcalc/standard/key/23.phtml 
The DiamCalc installation contains a set of report templates for different cuttings. 
They are placed in the REPORTS subfolder. You may customize provided RTF report 
templates in MS Word or create your own taking existing templates as examples. 
Please note that MS Word report templates should be saved in RTF format. HTML 
report templates also may be customized. Use your favorite HTML editor for it. Here 
is an example of how the «Illustrated color report for round brilliant» looks like. 
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More examples of new DiamCalc reports for Helium and Sarin scanned polished 
brilliants on the web-site: 
 http://www.octonus.com/oct/products/3dcalc/standard/reports-dc-rbc.phtml 
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18 Diamond Calculator FAQ 

18.1  I can not make a change of 1/10 degree while modifying ASCII 
file. Is there a way to refine the change? 

You may enter the desired value directly. Press Enter to apply the changes. 

18.2 How do I place a movie recorded by the DiamCalc on a web 
site? 

The DiamCalc allows exporting of the generated movies into common AVI format. 
Moreover, during export you may choose the desired codec from the list of codecs 
installed in your system for encoding your movie. Thus you may share your movies 
with everyone through your web site. If you want the movie to play directly on your 
web-page without explicit download of the file you may convert AVI file into 
animated GIF format with third-party programs. In this case we recommend saving the 
source AVI file without compression to avoid artifacts caused by lossy compression. 

18.3  How can I make fancy color photoreal pictures with DiamCalc? 

The present version of DiamCalc allows to select from two predefined colors (choose 
menu item Gem material  Standard types), but you may enter arbitrary absorption 
spectrum (Gem material  View/Modify properties). In the «Gem properties» on the 
«General» tab click the «Add» button. This will add an «Absorption» tab that allows 
to specify the absorption spectrum. You need to know absorption characteristics of 
your stone to get accurate results (see section Adjust the gem material characteristics). 
We are planning to enlarge the list of predefined materials in future versions of 
DiamCalc. 

18.4 What is spread? 

The spread is parameter showing the difference between the weight of the given 
diamond and the weight of the «standard diamond». The «standard diamond» has the 
same area as the given diamond but Tolkowsky proportions with the medium girdle 
thickness. The spread parameter tells you if your diamond looks more or less massive 
than it really is. The spread parameter also works with fancy shapes comparing them 
with round «standard diamond». The spread indication is available only in the 
registered version. 

18.5 What is AGS spread? 

NW = C (6.47 / D)3 
C - weight of diamond (ct) 
D - diameter of diamond (mm) 
6.47 - diameter in mm of diamond with weight 1 ct and Tolkowsky proportions 
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18.6 What is gamma correction? 

As human eye perception of the brightness is not linear with the light intensity (in fact, 
it is close to «Gamma function») the modern monitors use the nonlinear pixel 
brightness to compensate this behavior and let the human to see computer colors 
having uniform brightness. For the most monitors the factor of that compensation 
(gamma) is about 2. For this case gamma correction in the DiamCalc should be 0.5. 
However, it may differ for different monitors (particularly it depends on the monitor’s 
control settings and settings of the video adapter driver), so you may adjust this 
parameter in the DiamCalc. We are planning to add a utility letting the user to define 
and adjust this value looking at test pictures in the future. 

18.7 What is the accuracy of the DiamCalc mass estimation? 

For convex shapes it is completely accurate. However, you should mention the 
following things: 

• In order to estimate the stone weight correctly you have to know the exact value 
of specific gravity of the gem material. 

• The real stone always slightly differ from the model that was used for cutting 
because accuracy of cutting process is limited (another reason - the real stone 
can have extra facets or omitted facets especially on the girdle). 

If you have suspicions about specific file then you may send to us this file and your 
suspicions and we will analyze it. 

18.8 Why does the DiamCalc valley girdle measurement produce 
negative values for very thin and extremely thin girdles, which 
does not match any charts? 

The charts usually contain bezel girdle measurement and DiamCalc takes it for a basis, 
while valley girdle measurement is calculated using mathematical model of the 
brilliant cut. An average stone with regular brilliant proportions has a valley girdle 
about 1.6-1.7 less than bezel girdle. Of course, the real stone can't have negative 
measurements, but DiamCalc doesn't discard negative results of computations in order 
not to lose information (to indicate how really thin it is). 

18.9 How to open GemCad GEM files in DiamCalc? 

Unfortunately, the format of the GemCad GEM files is not open, but you can load 
them in GemCad and then save in ASCII format. To import GemCad ASCII files use 
menu command Cut  Import cut  From GemCad ASC file. 

18.10 How can I contact the DiamCalc support? 

If you have any problems with the DiamCalc or have any suggestions for its 
improvements you may always send a message from our web-site: 
http://www.octonus.com/oct/support/SubmitTicket.phtml 
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19 Purchase DC3 and upgrade from DC2 
If you have a Hasp version of DiamCalc - simply download the latest DC3 version 
from here http://www.octonus.com/oct/download/diam_demo_down.phtml Your 
upgrade is free. That key is the one shown in the picture. 
If you have a downloaded version of DiamCalc2.x without a HASP key then please 
click this link http://www.ideal-scope.com/formmail/dcupgrade.html add your 

company information and registration key number that 
you can find by opening DC2 and clicking on Help (top 
right) and then Registration Info.... (Please copy and paste 
the key #’s to avoid errors).  After Key confirmation 
OctoNus will send you an email with an Ideal-scope.com 
link where for $85 plus delivery you can pay by secure 
credit card payment for delivery of the hasp key - shown 
on the bottom. (This covers the cost and handling of the 

key - the upgrade is essentially free). 
If you wish to upgrade from DC2.x Hasp version to DC3Pro then go to www.ideal-
scope.com Meanwhile please post your old DC2 long hasp key to Ideal-scope 110-114 
Canterbury Road, Canterbury, 3126 Australia and you will be eligible for a $295 
discounted upgrade at $3,700 including a new DC3 hasp key. 
 
New DC3pro is available for $3,950 at www.ideal-scope.com  
 
Any DC3 version can be upgraded for $3,650 by simply filling out the form at 
http://www.ideal-scope.com/formmail/dcupgrade.html & updating your program 
from http://www.octonus.com/oct/download/diam_demo_down.phtml  
 
Additional DC3 licenses can be purchased for $395 from http://www.ideal-
scope.com/cart_zoom_item.asp?Id=12&ShowAdd=Y  
 
All software should be downloaded from the latest most recent versions are here: 
http://www.octonus.com/oct/download/diam_demo_down.phtml  

http://www.octonus.com/oct/download/diam_demo_down.phtml
http://www.ideal-scope.com/formmail/dcupgrade.html
http://www.ideal-scope.com/
http://www.ideal-scope.com/
http://www.ideal-scope.com/
http://www.ideal-scope.com/formmail/dcupgrade.html
http://www.octonus.com/oct/download/diam_demo_down.phtml
http://www.ideal-scope.com/cart_zoom_item.asp?Id=12&ShowAdd=Y
http://www.ideal-scope.com/cart_zoom_item.asp?Id=12&ShowAdd=Y
http://www.octonus.com/oct/download/diam_demo_down.phtml
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20 Appendix 
For additional documentation on DiamCalc, refer to OctoNus Software Web pages. 
The main page of DiamCalc is http://www.octonus.com/oct/products/3dcalc/standard/ 
Additionally, there are information on understanding and modifying of diamond 
appraising criteria and price lists that are used by DiamCalc. Look there for up-to-date 
information related to DiamCalc. 
 
Over the coming months www.OctoNus.com will launch help group Forums and 
Video Tutorials to answer FAQ’s. We invite you to participate. 
 
The OctoNus DiamCalc team wishes you great productivity from the new tools added 
to DiamCalc. We also welcome feedback and suggestions for improvements. 
 

http://www.octonus.com/
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